
Ensure document is current before use 
© Airservices Australia 2022 1 of 64 

OFFICIAL 

Firemon Alarm Signalling Equipment (ASE) 
Installation Checklist 

Technical Instruction 

TI-0157 

Version 20 

Effective 27 November 2024 



Firemon Alarm Signalling Equipment (ASE) Installation Checklist Technical Instruction 

2 of 64 Version 20: Effective 27 November 2024 TI-0157 

OFFICIAL 

Change Summary 

Version Date Change description 

20 27 November 2024 Update checklists and procedures 

Include Alteration of Service checklist 

Include additional checklists for RM3118 ASEs 

Update document template 

19 11 December 2023 Restore missing section 7 

18 18 November 2023 Clear comments 

17 17 November 2023 Romteck RM3119 release 

This document was created using Technical Instruction Template C-TEMP0168 Version 9. 



Firemon Alarm Signalling Equipment (ASE) Installation Checklist Technical Instruction 

TI-0157 Version 20: Effective 27 November 2024 3 of 64 

OFFICIAL 

Table of Contents 

1 Purpose ...................................................................................................................................... 4 

2 Background ............................................................................................................................... 4 

3 Scope ......................................................................................................................................... 4 

4 Responsibility ........................................................................................................................... 5 

5 Legal Obligations ...................................................................................................................... 8 

5.1 Managing an Isolated Alarm System, Partial Isolation or Temporary Disconnection: Alternative 

Fire Safety Procedures ....................................................................................................................................... 8 

5.2 Can an ASE be (Completely or Partially) Temporarily Disconnected? ...................................... 8 

5.3 Can an ASE be Permanently Disconnected? ............................................................................. 9 

6 How to Become an Airservices Certified Maintainer or ASE Key Holder ........................... 9 

7 Hardware Configuration ......................................................................................................... 10 

7.1 RM3119 Hardware Configuration ............................................................................................. 10 

7.2 Antennas ................................................................................................................................... 10 

7.3 Touch Keys ............................................................................................................................... 14 

8 Acceptance Criteria ................................................................................................................ 15 

9 ASE Interfacing ....................................................................................................................... 15 

9.1 ASE to FDCIE Interfacing ......................................................................................................... 15 

9.2 ASE to Communications Network Interfacing .......................................................................... 18 

10 Antenna Installation ............................................................................................................... 18 

11 New RM3119 Dual SIM ASE Installation ............................................................................... 19 

11.1 ASE Configuration and Testing ................................................................................................ 20 

11.2 RM3119 ASE Installation Checklist .......................................................................................... 31 

12 Alteration of Service (RM3119) .............................................................................................. 37 

13 Alteration of Service (RM3118) .............................................................................................. 42 

14 Disconnecting and Reconnecting of an ASE (RM3119) ..................................................... 46 

15 Disconnecting and Reconnecting of an ASE (RM3118) ..................................................... 49 

16 Replacement ASE ................................................................................................................... 52 

17 Replacement SIM .................................................................................................................... 52 

18 Misuse of Airservices SIMs ................................................................................................... 52 

19 ASE Decommissioning .......................................................................................................... 53 

20 Definitions ............................................................................................................................... 54 

21 References ............................................................................................................................... 55 

Appendix A How to Backup or Restore RM3119 Dual SIM ASE Configuration .................................... 56 

A.1 ASE Config Software ................................................................................................................ 56 

Appendix B ARFFS Contact details ........................................................................................................... 61 

Appendix C Notification Form 204 Explanations & ASE Status Screen ................................................ 62 

Appendix D Notification Form 204 High Number of FDCIE Faults ......................................................... 63 



 
 Firemon Alarm Signalling Equipment (ASE) Installation Checklist Technical Instruction  

4 of 64 Version 20: Effective 27 November 2024 TI-0157 

 

OFFICIAL 

1 Purpose 

This document defines the checks to be completed by the installer during the installation, 

modification and decommissioning of Alarm Signalling Equipment (ASE) for the Fire Alarm 

Monitoring System. 

This document is to be used during the installation of each ASE prior to alarms being put into 

operational use. It is also to be used for any modifications to ASEs including relocations, 

replacements, and input modifications. 

2 Background 
The decommissioning of the 3G network by mobile carriers requires the replacement of existing 

legacy Alarm Signalling Equipment (ASE) devices which utilise these services for connectivity. 

The latest generation Alarm Signalling Equipment (ASE) devices called the Romteck RM3119 are 

being rolled out to replace existing legacy RM2118 and RM3118 “Lisa” (3G only) devices at 

monitored sites. The RM3119 device contains two mobile data modems, which provide a 

redundant uplink to the alarm monitoring network via two carriers, Telstra and Optus. The two 

SIMs required for the uplink are supplied by Airservices. 

The existing 3G/4G RM3118 Telit ASEs will remain in service until the decommissioning of the 4G 

network. 

3 Scope 
This document applies to both the Contractor/Installer/Customers and Airservices Australia 

personnel in preparation for commissioning of an ASE. 

It summarises test results captured as part of installation procedures at a single ASE site. 
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4 Responsibility 
During the time that an ASE is not fully operational, it is vital for the customer to put in place 

alternative fire safety protections to ensure an appropriate level of fire safety during the outage.  

To assist all building owners and managers to know their rights and responsibilities in relation to 

automatic alarm monitoring, an information guide (Monitored Automatic Alarms) has been 

developed as a joint initiative by the Victorian Building Authority, CFA, MFB, ADT, Chubb and 

Romteck GRID. 

 

It is the responsibility of the customer to: 

1. Must be aware and comply with all Building Regulations. 

2. If their monitored automatic alarm system is not fully operational, it is vital to put alternative fire 

safety procedures in place to ensure an appropriate level of fire safety during this period. 

3. As outlined in How to Apply for Airservices Automatic Fire Alarm Monitoring, for new 

installations or upgrades, ensure an Application for Automatic Fire Alarm Monitoring Service 

form has been received by Airservices. 

a. Wait for written approval from arfffirealarmmonitoring@airservicesaustralia.com. 

b. Provide local ARFFS staff with keys and other applicable information about the building. 

c. Order the ASE and all associated equipment as defined in Section 7. 

d. Organise an Airservices Certified Maintainer to configure and install the ASE. 

A list of accredited installers is available via: Airservices_ASE_Installers 

e. Airservices will send the Telstra and Optus SIMs to your nominated Airservices Certified 

Maintainer. 

f. Ensure the Installation Checklist in Section 11 is completed and has been e-mailed to 

Airservices by your Airservices Certified Maintainer. 

g. The Airservices Certified Maintainer is to organise a suitable date and time to perform 

end-to-end testing with Airservices. 

h. A confirmation email will be provided by Airservices to notify the customer that 

commissioning has been completed successfully. 

4. To modify the Services monitored by ARFF, an Application for Automatic Fire Alarm 

Monitoring Service form requesting an “Alteration of Service” must be submitted to 

arfffirealarmmonitoring@airservicesaustralia.com. Alteration of Service checklist shall be used 

to commission the new input(s). 

5. Once an ASE is installed, a building permit from a registered building surveyor must be 

obtained to disconnect it. To decommission an ASE, an Application for Automatic Fire Alarm 

Monitoring Service form requesting a “Removal of Service” must be submitted to 

arfffirealarmmonitoring@airservicesaustralia.com 

The ASE Decommissioning checklist in Section 19 must be completed. 

6. An inspection and testing of a completed installation may be carried out by ARFFS. When a 

re-inspection of an ASE is required due to the installation not complying fully with the 

installation checklists or the standard of work for some reason is unacceptable at the time of 

the inspection, a re-inspection fee may be levied on the customer. 

7. Ensure the installation, maintenance and repair of ASEs complies with the requirements of the 

relevant Australian Standards. 

https://www.cfa.vic.gov.au/ArticleDocuments/550/Publication_Monitored_Automatic_Alarms_A4_x_4_pages.pdf
https://www.airservicesaustralia.com/wp-content/uploads/How-to-Apply-for-Automatic-Fire-Alarm-Monitoring.pdf
https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
mailto:arfffirealarmmonitoring@airservicesaustralia.com
https://www.airservicesaustralia.com/wp-content/uploads/Airservices_ASE_Installers.pdf
https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
mailto:arfffirealarmmonitoring@airservicesaustralia.com
https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
mailto:arfffirealarmmonitoring@airservicesaustralia.com
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8. The ASE configuration is used to rebuild a failed ASE to meet Australian Standard restoration 

times. The ASE configuration is to be archived and stored as per the customer’s company’s 

policy. Airservices takes no responsibility for archiving or storage of the ASE configuration. 

Note: No routine maintenance is required specifically for the ASEs. End-to-end testing of the 

ASE is performed as part of the monthly Australian Standards Fire Alarm checks (AS1851-

2012). 

 

Romteck Australia (https://www.romteck.com/) will supply: 

1. New and replacement hardware as per Section 7. 

2. Manage ASE and associated equipment Warranty provisions. 

3. ASE Maintenance Configuration and Diagnostics Software for ASE and FSE Devices 

Operators Manual, version Revision 0.5 or greater 

4. Romteck ASE CONFIG Operation Manual, version 0.1 or greater 

5. Romteck RM3119 ASE Installation Manual, version 0.1 or greater 

6. Romteck RM3119 ASE Operations Manual, version 0.1 or greater 

7. ASE RM3118 Alarm Signalling Equipment (ASE) Operation and Installation Manual, Revision 

0.4 or greater 

 

It is the responsibility of the installer/maintainer technician to: 

1. Understand that while a monitored automatic alarm system is not fully operational, it is vital to 

put alternative fire safety procedures in place to ensure an appropriate level of fire safety 

during this period. 

2. Diligently follow the instructions contained within this document where applicable. 

3. The ASE is fitted with an electronic key, the maintainer is to retain a record of who those keys 

are assigned to. Will not give the key to anyone else to use. It is only for your use in 

accordance with your operational need and work requirement. 

4. Routine servicing end-to-end system checks are to be performed as part of the AS1851 

monthly FDCIE checks. 

5. Maintain after hours or emergency contact numbers for the building.  When a fault is detected 

in an ASE or FDCIE which requires repairs to be undertaken, every effort must be made to 

complete the repairs as soon as possible. 

6. Hold sufficient spare ASEs to meet Australian Standards restoration times. 

7. Section 11 checklist shall be used to configure, install and commission a new ASE RM3119 or 

upgrading from a RM2118 / RM3118 to a RM3119. 

8. Should an existing ASE be disconnected and reconnected for any reason, upon the 

reconnection the Section 14 or Section 15 checks shall be conducted and emailed to 

Airservices. 

9. An e-mail must be sent to ARFFS when isolations are planned and likely to be over an 

extended period. Unplanned short-term isolations, the technician may advise ARFFS via 

phone. 

https://www.romteck.com/
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10. Arrange a time to perform live end-to-end commissioning testing. 

Note: ‘Live end-to-end’ commissioning testing activities occurs during normal business hours 

(Australian Eastern Standard Time). 

11. Perform live end-to-end commissioning testing. Commissioning involves testing the primary 

and secondary communication paths and their signal strength. An end-to-end test is performed 

from the FDCIE through to the ARFFS station. All inputs connected to the ASE must be tested. 

12. Provide the Customer a backup of the ASE configuration. 

 

It is the responsibility of an ASE key holder to: 

1. Understand that while a monitored automatic alarm system is not fully operational, it is vital to 

put alternative fire safety procedures in place to ensure an appropriate level of fire safety 

during this period. 

2. Diligently follow the instructions contained within this document where applicable. 

3. Only use the key in accordance with operational need and work requirement. 

4. Not give or lend the key to anyone else. 

5. Perform routine servicing end-to-end system checks as part of the AS1851 monthly FDCIE 

checks. 

6. Notify ARFFS via email when isolations are planned and likely to be over an extended period. 

For unplanned short-term isolations, the technician may advise ARFFS via phone. 

 

It is the responsibility of Airservices to: 

1. Provide technicians with a single point of contact for the Airservices System. This support is 

available business hours Australian Eastern Standard Time via 

arffsystemsupport@airservicesaustralia.com. 

2. Provide the Telstra SIM, Optus SIM and ASE configuration.  

3. For new installations, to create an alarm shell in Firemon.  

4. Local ARFFS staff will collect Building keys and other routine information about the building. 

5. Assist in performing live end-to-end commissioning testing. 

6. Generate an internal Commissioning Test Report.  

7. Provide a commissioning report to the Customer. 

 

  

mailto:arffsystemsupport@airservicesaustralia.com
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5 Legal Obligations 
The customer and technicians must comply with all state and territory regulations. 

Fire alarm systems are complex in design and need to be maintained by a reputable fire 

maintenance company that has expertise in this field. 

It is now an offence in most states and territories to damage or interfere with a fire indicator panel 

or other apparatus that transmits the signal to the fire services (monitored automatic alarm system) 

without reasonable excuse. Interference of this kind includes any action that causes the 

transmission of the signal to the fire service to be isolated, disconnected or disabled. This means 

that interfering with the ASE without a reasonable excuse is also an offence.  Refer to Monitored 

Automatic Guidelines (Monitored Automatic Alarms) for more advice on managing an ASE. 

Airservices recommends the customer adopt a minimum isolation policy. ASE isolations are not to 

be made to prevent false alarms from normal day to day activities.  

If the monitored automatic alarm system is not fully operational, it is vital for the customer to put 

alternative fire safety procedures in place to ensure an appropriate level of fire safety during this 

period. 

 

5.1 Managing an Isolated Alarm System, Partial Isolation or 

Temporary Disconnection: 

Alternative Fire Safety Procedures 

ASE isolations are not to be made to prevent false alarms from normal day to day activities. 

Follow the instructions provided by the relevant building surveyor with the building permit or 

occupancy permit. If these are not provided, please consider the actions outlined in Monitored 

Automatic Guidelines (Monitored Automatic Alarms). 

 

5.2 Can an ASE be (Completely or Partially) Temporarily 

Disconnected? 

For emergency work (e.g., in the case of equipment breakdown), or for prolonged maintenance 

requirements that require the ASE or its separate inputs to be disconnected, Airservices may agree 

to a written request to disconnect an ASE for a maximum of 24 hours without a building permit.  

For all other temporary disconnections, a building permit must be obtained, and a copy provided to 

Airservices together with a reconnection date or best estimate for the length of the disconnection. 

Examples of when temporary disconnections are required:  

 For structural renovation affecting the entire site protected by the ASE.  

 For non-occupancy of building – ensure the site and/or building is made secure. 

 

https://www.cfa.vic.gov.au/ArticleDocuments/550/Publication_Monitored_Automatic_Alarms_A4_x_4_pages.pdf
https://www.cfa.vic.gov.au/ArticleDocuments/550/Publication_Monitored_Automatic_Alarms_A4_x_4_pages.pdf
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5.3 Can an ASE be Permanently Disconnected? 

Once an ASE is installed, a building permit from a registered building surveyor must be obtained to 

disconnect an ASE. 

6 How to Become an Airservices Certified 
Maintainer or ASE Key Holder 

Fire alarm systems are complex in design and need to be maintained by a reputable fire 

maintenance company that has expertise in this field. The Airservices Certification process is a 

necessary part of the briefing the technicians must undergo before working on an ASE connected 

to the Airservices system. It is essential for the customer to confirm their technicians have had the 

minimum training. The certification is valid for 5 years. Upon expiry of the certification, the 

assessment must be retaken. 

Airservices Certified Maintainer or ASE key-holder request form is available via the following link 

TI-0223. 

https://www.airservicesaustralia.com/wp-content/uploads/TI-0223-Certified-Maintainer-Assessment-for-ASE.pdf
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7 Hardware Configuration 
This section contains the current standard configuration and other important information. 

7.1 RM3119 Hardware Configuration 

Order the following equipment directly from Romteck Australia. 

37 Collingwood St, Osborne Park WA 6017 Phone: +61 8 9244 3011  

Airservices standard configuration includes the following hardware: 

New 
Quantity 

Replacement 
Quantity 

Equipment 

1 1 Romteck RM3119-WIP-WIP-ASE-F 

2 See Antennas PID 27389 Benelec 024584 Cellular 5G Dipole Antenna 

2 See Antennas PID 9988 Benelec 02729 Stainless Steel Wall Bracket 58mm 

1 1 Romteck 470-ohm Resistor Board 

2 2 
Airservices will supply the Telstra and Optus SIMs for the RM3119 

ASEs. 

Note: If there is poor mobile reception on site a 3 metre or 5 metre coaxial cable may be required. 

 

7.2 Antennas 

Please read the following important information if you are replacing an existing ASE. 

7.2.1 Benelec 024584 Cellular 5G Dipole Antenna 

The Benelec 024584 Cellular 5G Dipole Antenna was also previously sold with RM3118 units for 

4G connectivity. Although it has since been renamed, it is the same model and covers the same 

frequencies. If you are replacing an RM3118 ASE, you may use the existing Benelec 024584 

antenna(s), and bracket(s) installed at the site and order the difference to meet the required 

quantity. 

Pictured on the following page are two variants of the Benelec 024584 antenna. An existing 4G 

labelled variant on the left, and the new 5G labelled variant on the right. Both variants cover the 

same frequencies. 
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7.2.2 Benelec 02458 Cellular (3G) Dual Band Antenna (Legacy) 

Important! 

The Benelec 02458 Cellular (3G) Dual Band Antenna is not authorised for use with the RM3119 

ASE. 

When identifying antennas, be sure not to mistake the Benelec 024584 4G/5G antenna for the 

Benelec 02458 3G antenna, which is pictured on the following page. 
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7.3 Touch Keys 

The RM3118/RM3119 ASEs use a Touch Key for access to key Test and key Isolate. Airservices 

is a Key Issuer and can issue keys with the key issuer code of “ASA”. Touch Keys may only be 

issued to Airservices Certified Maintainers or ASE key-holders. Refer to Section 6. 

Only valid keys may be used on the RM3118/RM3119 ASE. ASEs monitored by ARFFS are 

configured to accept keys from ALL key issuers. 

Firemon records an audit trail of when a key is used to access the ASE. Firemon records the key 

issuer, key number and key serial number. Firemon also records events such as key Test and 

Isolation events. 

Touch Keys are ordered via the TI-0223 process. 

 

  

https://www.airservicesaustralia.com/wp-content/uploads/TI-0223-Certified-Maintainer-Assessment-for-ASE.pdf
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8 Acceptance Criteria 
Once all checks listed in Section 11 (new ASE installation) or Section 12 or Section 13 (alteration 

of existing ASE) are successfully completed by the installer, a signed copy of the checklist shall be 

emailed to Airservices. 

9 ASE Interfacing 

9.1 ASE to FDCIE Interfacing 

The ASE shall be connected to the Fire Detection Control and Indicating Equipment (FDCIE) relay 

contacts via a 470-ohm resistor board for monitoring of: 

- “Fire Alarm” 

- “System Fault” 

- “Disconnected / Isolated” 

- “Power Fault” 

Refer to the wiring diagrams on the following two pages. 
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N.C.
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To offboard
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SMA connector

ASE to FDCIE Wiring Diagram
FDCIE with SPDT relay contacts, 470 ohm resistor board
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FDCIE with SPST relay contacts, 470 ohm resistor board
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9.2 ASE to Communications Network Interfacing 

The ASE acquires the alarm signals from the Fire Detection Control and Indicating Equipment 

(FDCIE) and transmits these to the Airservices Firemon system using two communications paths. 

The primary path is via Telstra, and the secondary path is via Optus. 

Note that both communications paths are required to meet the reliability requirements in Australian 

Standard AS-1670.3. 

10 Antenna Installation 
The two antennas must be installed as per the Romteck RM3119 ASE Installation Manual: 

 Never mount an antenna where it is likely to be within 200mm of a person’s head. 

 Never mount an antenna inside the FDCIE cabinet. 

This not only compromises the signal strength but can also interfere with the FDCIE. 

 ASE antennas must not be mounted near other equipment’s antennas. 

Refer to section 3.3.2.1 "Dual Antenna Separation" in the Romteck RM3119 ASE Installation 

Manual. 

 ASE antennas must be suitably separated from each other. 

Refer to section 3.3.2.1 "Dual Antenna Separation" in the Romteck RM3119 ASE Installation 

Manual. 

 Antenna cable should be kept as short as possible or low loss cable used to minimise signal 

loss. 

 ASE antenna must not be mounted where they are susceptible to vandals. 

 ASE antenna type and location must be such as to ensure suitable signal levels in all 

operating bands. 

If there is poor mobile phone signal on site, adjusting the location and orientation of the antenna 

will make a marked difference to improving the reception.  A 3 or 5 metre coaxial cable can be 

provided by Romteck Australia on request. 
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11 New RM3119 Dual SIM ASE Installation 
The following checklist is to be used when installing or upgrading to the RM3119 ASE. 

It must be completed by the installer.  

If installing a new RM3119 ASE: 

 A Fire Alarm Monitoring Service Form must have already been submitted and accepted by 

arfffirealarmmonitoring@airservicesaustralia.com. 

 Order equipment as per Section 7. 

 Airservices will express post the following to the nominated Airservices Certified Maintainer: 

o Telstra and Optus micro-SIMs  

o A copy of TI-0157 pre-filled with the required information. 

 Airservices will provide the following information via e-mail to the nominated Airservices 

Certified Maintainer: 

o Zip file containing the baseline configuration device for ASEs connected to the Airservices 

system 

o Site  

o Device Number  

o Device Name 

o Telstra Username, password and SIM IMSI 

o Optus Username, password and SIM IMSI 

o Concentrator, Module, Line and Drop 

 Section 11.1 checklist shall be used to configure the ASE to connect to the Firemon test 

system.  When configured, the new ASE will talk to the Airservices test network and hence 

alarms will not be displayed in the ARFFS Station. 

 Section 11.2 checklist is completed just prior and during live end-to-end commissioning 

testing. To ensure availability of all personnel, it is recommended this communication with 

arffsystemsupport@airservicesaustralia.com is made well before the installer goes to site. 

 

 

  

https://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
mailto:arfffirealarmmonitoring@airservicesaustralia.com
mailto:arffsystemsupport@airservicesaustralia.com
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11.1 ASE Configuration and Testing 

This section details the procedures to configure an ASE prior to on-site installation. 

11.1.1 RM3119 Baseline Configuration Device 

The RM3119 baseline configuration device is a device template used to configure new RM3119 

ASEs prior to installation. This procedure details the steps to import the device into the ASE Config 

application. 

If you have already imported the latest RM3119 baseline configuration device into the ASE Config 

application, skip this procedure. 

 

1. Launch the Romteck ASE Config application. 

2. Optional: Navigate to “Setup” => “System Settings”, 

and set “Data Directory” to a desired location. 

3. Navigate to “File” => “Import Device(s)…”. 

Browse to and select “ASE_Baseline_1002_V3.zip” and click “Open” to import it. 

Click “OK” on the import successful prompt. 
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11.1.2 Contact Simulator 

The contact simulator is a test device used to simulate the relay contacts of a FDCIE upon the 

ASE’s inputs. 

Pictured below is an example constructed out of 4 SPDT toggle switches mounted inside an ABS 

enclosure. Wiring is done with offcuts of CAT-5 cable (stranded core) terminated with 24 AWG 

bootlace ferrules. It is connected to a Romteck 470-ohm resistor board for testing RM3119 ASEs. 

 

 

 

If you are configuring an ASE with additional inputs enabled, make sure you have an additional 

contact simulator and Romteck 470-ohm resistor board available. 
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11.1.3 ASE Configuration 

This procedure details the steps to connect and configure an ASE prior to on-site installation. 

 

1) Ensure the ASE is powered off. 

2) Install the Telstra micro-SIM into the onboard modem’s micro-SIM socket. 

3) Install the Optus micro-SIM into the offboard modem’s micro-SIM socket. 

4) Connect the two Benelec 024584 antennas to the ASE’s two SMA terminated antenna leads. 

5) Connect the Romteck RM3119 Programming Adaptor to the ASE’s onboard serial 

connector “P6”. 

Use a USB-C cable to connect the Romteck RM3119 Programming Adaptor to your PC or 

laptop. 

6) Connect your contact simulator via a 470-ohm resistor board to connector “P3”. 

If you need to configure and test additional inputs, connect an additional contact simulator 

via an additional 470-ohm resistor board to connector “P2”. 

7) Connect the ASE’s DC power supply to connector “P7”, then power on the ASE. 

Power is supplied via pin 4 (negative) and pin 5 (positive) of connector “P7”. 

The ASE operates on any DC power supply between 8V to 30V. 

 

Continued on next page. 
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Connector “P7” 
Power to pin 4 (negative) 

and pin 5 (positive) 

Onboard modem’s micro-SIM socket 
(Install Telstra micro-SIM here) 

Offboard modem’s micro-SIM socket 
(Install Optus micro-SIM here) 

Connector “P3” 
To resistor board and 

contact simulator 

Connector “P6” 
To Romteck RM3119 
Programming Adaptor 

Romteck RM3119 
Programming Adaptor 

To ASE Config PC / 
Laptop via USB-C cable 

Connections to Benelec 024584 antennas 
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8) Launch the ASE Config application. 

9) Navigate to “Setup” => “System Settings…” and select the “Communication Settings” tab. 

Ensure “Com Port:” is set to the correct port, then click “OK”. 

Hint: The exact COM port number associated with the Romteck RM3119 Programming Adaptor will depend on 

your system, the USB port used, as well as the number of existing COM ports present. To check COM port 

allocations, open “Device Manager” and expand “Ports (COM & LPT)”, then look for “USB Serial Port (COM#)” 

where “#” is the COM port number. 

10) Sort the device list by clicking on the “Firemon Device No” column header, then locate 

Firemon Device No 1002. 

This blank ASE contains the Airservices baseline configuration, which is configured to connect 

to the TEST system. 

11) Right-click Firemon Device No 1002 and select “Copy Device”. 

This will create a copy which is then highlighted. 

12) Right-click on the newly created copy and select “Connect”. 

This will connect to the ASE and open the device configuration window. 

If an “Address Mismatch” message appears, click “OK”. 

 

 

Continued on next page. 
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13) Select the “Device Details” tab and update the following details using the information provided 

by Airservices (indicated in red in the image below): 

a) “Concentrator” 

b) “Module” 

c) “Line” 

d) “Drop” 

e) “Firemon Device No” 

f) In the “Building” field, use the naming convention: “XX-Building Name”. 

Where “XX" is the region and “Building Name" is the name of the building. 

 

 

 

Continued on next page. 
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14) Select the “Configuration” tab and update the following details (indicated in red in the image 

below): 

a) In the “LCD Title:” field, enter “DEVICE ###”, 

where “###” is the Firemon Device No. 

b) In the “Low Voltage:” field, enter a value approximately 10% below the installed FDCIE 

power supply voltage. 

 

 

 

Continued on next page. 

 

  



 
 Firemon Alarm Signalling Equipment (ASE) Installation Checklist Technical Instruction  

TI-0157 Version 20: Effective 27 November 2024 27 of 64 

 

OFFICIAL 

15) Select the “IP Configuration” tab. 

16) Under the “IP Configuration” tab, select the “WIP 1 (IP Configuration #1)” tab and update 

the following details (indicated in red in the image below): 

a) In the “User Name:” field, enter the Telstra user ID provided by Airservices. 

b) In the “Password:” field, enter the password provided by Airservices. 

 

 

Note: For RM3118/9 ASEs, the PIN will be disabled (i.e., 0000) 

 

Continued on next page. 
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17) Under the “IP Configuration” tab, select the “WIP 2 (IP Configuration #2)” tab and update 

the following details (indicated in red in the image below): 

a) In the “User Name:” field, enter the Optus user ID provided by Airservices. 

b) In the “Password:” field, enter the password provided by Airservices. 

 

 

Note: For RM3118/9 ASEs, the PIN will be disabled (i.e., 0000) 

 

Continued on next page. 
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18) If no additional inputs are required, skip to Step 21. 

19) Select the “Point Configuration” tab, then select the “Input Points” subtab. 

20) For each additional input to be enabled, do the below steps. Do NOT modify inputs 1 to 4. 

a) Untick the “Unused” checkbox. 

b) Set the “Type” field to: 

“Fire Alarm” if alarm type is PRIMARY. 

“Fault Warning” if the alarm type is SECONDARY. 

c) Tick the “Send Extra Info” checkbox. 

d) Set the “Extra Info” field to the alarm’s description. 

 

Example: Additional input 5 configured for a “Sprinkler” alarm. 

 

21) Click “Write Configuration” to write the configuration changes to the ASE. 

22) Click “Save Changes” to save the configuration in the local ASE Config database. 

23) Close the device configuration window. 

24) Close the ASE Config application. 

25) Disconnect the USB connection to the ASE and unplug the RM3119 Programming Adaptor. 
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11.1.4 ASE Testing 

This procedure details the steps to test an ASE prior to on-site installation. 

 

1) Ensure the Up and Down arrows by the primary path “P” signal meter are alternatively 

flashing. 

2) Ensure the signal strength for the primary path “P” is displaying -109dBm or greater. 

3) Ensure the signal strength for the secondary path “S” is displaying -109dBm or greater. 

4) Using the contact simulator: 

a) Open the “ALARM” switch and verify “ALM” appears on the ASE’s LCD screen. 

Close the “ALARM” switch. 

b) Open the “FAULT” switch and verify “FLT” appears on the ASE’s LCD screen. 

Close the “FAULT” switch. 

c) Open the “ISO/DIS” switch and verify “DIS” appears on the ASE’s LCD screen. 

Close the “ISO/DIS” switch. 

d) Open the “POWER” switch and verify “PWR” appears on the ASE’s LCD screen. 

Close the “POWER” switch. 

5) Using the additional contact simulator (if applicable): 

a) If Input 5 is configured, open the Input 5 switch. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Close the Input 5 switch. 

b) If Input 6 is configured, open the Input 6 switch. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Close the Input 6 switch. 

c) If Input 7 is configured, open the Input 7 switch. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Close the Input 7 switch. 

d) If Input 8 is configured, open the Input 8 switch. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Close the Input 8 switch. 

6) Power off the ASE. 

7) Disconnect the ASE. 
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11.2 RM3119 ASE Installation Checklist 

 

Installer’s Name:  

Mobile Number:  

ASID Reference:  Device Number:  

Building Name:  

Building Address:  

Note: When initially configured, the ASE will communicate with the Airservices test network and 

hence alarms will not be displayed in the fire station. 

The following checklist is to be completed by the installer: 

CHECK ITEM Yes N/A 

Email arffsystemsupport@airservicesaustralia.com to organise a preferred time.   

Call the local ARFFS station and advise them you are on site to perform the installation. 

If replacing an existing ASE, advise them at the ASE will be offline for the replacement. 

  

  

Remove legacy Benelec 02458 3G antennas, if present. See Section 7.2.   

Two Benelec 024584 4G/5G antennas installed. See Section 7.2 and Section 10.   

Appropriate lightning and surge protection installed, if required.   

Any penetrations sealed and waterproofed.   

Inputs 1, 2, 3 and 4 are connected to the FDCIE via 470-ohm resistor board as per Section 9.   

The ASE’s LCD screen shows status of “Normal”.   

The ASE’s primary (onboard) modem is connected to Airservices via Telstra. 

The LCD screen shows a signal strength for the primary path “P”, not flashing, 

and with alternating up/down arrow icon. 

  

  

The ASE’s secondary (offboard) modem is connected to Airservices via Optus. 

The LCD screen shows a signal strength for the secondary path “S”, and not flashing. 

  

  

Record the signal strength for the primary path “P”: 

Signal Strength: -  dBm 

For 4G network connectivity, the signal strength must be -109dBm or greater. 

  

  

Record the signal strength for the secondary path “S”: 

Signal Strength: -  dBm 

For 4G network connectivity, the signal strength must be -109dBm or greater. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

The ASE’s “Low Voltage” threshold is approximately 10% below the DC power supply voltage.   

Measure and record the voltage drop across the terminals for Input 1 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 2 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 3 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 4 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Activate Alarm on Input 1. 

Verify “ALM” appears on the ASE’s LCD. 

Clear the Alarm. 

  

  

Activate System Fault on Input 2. 

Verify “FLT” appears on the ASE’s LCD. 

Clear the System Fault. 

  

  

Activate Isolated / Disconnected on Input 3. 

Verify “DIS” appears on the ASE’s LCD. 

Clear the Isolated / Disconnected status. 

  

  

Activate the Power Fault on Input 4. 

Verify “PWR” appears on the ASE’s LCD. 

Clear the Power Fault. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Record the details for the additional alarm being wired to Input 5. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 6. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 7. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 8. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Measure and record the voltage drop across the terminals for Input 5 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 6 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 7 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 8 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Activate the alarm on Input 5. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 6. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 7. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 8. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

 
Continued on next page.  
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CHECK ITEM Yes N/A 

Place the ASE into test mode.   

Call Airservices ARFFS System Support. 

 

Confirm the following details: 

1) Your Name and Phone Number. 

2) The Building Name, Building Address and the ASE Device Number. 

3) The details of any additional alarms. 

 

Keep the ASE in test mode until instructed otherwise. 

 

Airservices will then perform the following activities: 

1) Make the appropriate checks and system modifications. 

2) Reconfigure the ASE to communicate with the operational network. 

3) Notify the local ARFFS station of end-to-end testing. 

4) Instruct you to remove the ASE from test mode. 

5) Instruct you to activate and clear connected alarms. 

  

  

When instructed, remove the ASE from test mode.   

When instructed, activate Alarm on Input 1. 

Wait for confirmation, then clear the Alarm. 

  

  

When instructed, activate System Fault on Input 2. 

Wait for confirmation, then clear the System Fault. 

  

  

When instructed, activate Isolated / Disconnected on Input 3. 

Wait for confirmation, then clear the Isolated / Disconnected status. 

  

  

When instructed, activate the Power Fault on Input 4. 

Wait for confirmation, then clear the Power Fault. 

  

  

When instructed, activate the alarm on Input 5. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 6. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 7. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 8. 

Wait for confirmation, then clear the alarm. 

  

  

 
Continued on next page.  
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CHECK ITEM Yes N/A 

Use the ASE Config application to take a backup of the ASE’s configuration. 

Store the backup as per your company’s policy. 

  

  

If upgrading from an RM3118, send Telstra and Optus SIMs to: 

ARFFS System Support 

Airservices Australia 

Alan Woods Building, 25 Constitution Avenue 

Canberra ACT 2601 

 

Airservices will de-activate the Telstra and Optus SIMs. 

  

  

 

Installer’s Signature:  Date:  

Comments:  

 

 

 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 
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12 Alteration of Service (RM3119) 
The installer must complete this checklist when modifying inputs on an existing RM3119 ASE. 

Prior to commencing this activity, an Application for Automatic Fire Alarm Monitoring Service form, 

requesting an Alteration of Service must be submitted to, and accepted by Airservices. 

Installer’s Name:  

Mobile Number:  

ASID Reference:  Device Number:  

Building Name:  

Building Address:  

 

CHECK ITEM Yes N/A 

Email arffsystemsupport@airservicesaustralia.com to organise a preferred time.   

Call the local ARFFS station and advise them you are on site to perform the alteration.   

Place the ASE into test mode prior to performing the alteration.   

Record the details for the additional alarm being wired to Input 5. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 6. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 7. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Record the details for the additional alarm being wired to Input 8. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

Alarm Type:  Either PRIMARY or SECONDARY 
 

  

  

Continued on next page.  
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CHECK ITEM Yes N/A 

Measure and record the voltage drop across the terminals for Input 5 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 6 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 7 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 8 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Do the following to enable or disable additional inputs on the ASE: 

1) Unscrew the four retaining screws on the ASE front panel and carefully remove it. 

2) Connect the Romteck RM3119 Programming Adaptor to the ASE’s onboard serial 
connector “P6”. Use a USB-C cable to connect the adaptor to your laptop. 

3) Launch the Romteck ASE Config application. 

4) Navigate to “Setup” => “System Settings...” and select the 
“Communication Settings” tab. 
Ensure “Com Port:” is set to the correct port, then click “OK”. 
Hint: The exact COM port number associated with the Romteck RM3119 Programming Adaptor will 
depend on your system, the USB port used, as well as the number of existing COM ports present. To 
check COM port allocations, open “Device Manager” and expand “Ports (COM & LPT)”, then look for 
“USB Serial Port (COM#)” where “#” is the COM port number. 

5) In the list of devices, locate the ASE by matching its “Firemon Device No” to the ASE’s 
Device Number per the information at the top of this checklist. 

6) Right-click on the device and click “Connect”. 
This will display the device configuration window. 

7) Verify you see “Comms State:   COMMS OK: ...” at the bottom of the window. 

8) Click “Read Configuration”. 
On the warning prompt, click “Yes”. 
On the information prompt, click “OK”. 

9) Select the “Point Configuration” tab, then select the “Input Points” subtab. 

10) For each additional input to be enabled, do the below steps. Do NOT modify inputs 1 to 4. 

a) Untick the “Unused” checkbox. 

b) Set the “Type” field to: 
“Fire Alarm” if alarm type is PRIMARY. 
“Fault Warning” if the alarm type is SECONDARY. 

c) Tick the “Send Extra Info” checkbox. 

d) Set the “Extra Info” field to the alarm’s description. 

11) For each additional input to be disabled, do the below steps. Do NOT modify inputs 1 to 4. 

a) Tick the “Unused” checkbox. 

b) Set the “Type” field to “Status”. 

c) Untick the “Send Extra Info” checkbox. 

d) Set the “Extra Info” field to “Auxiliary #” 
Where “#” is the value of “Point No” minus 4. 

12) Click “Write Configuration”. 
On the information prompt, click “OK”. 

13) Click “Save Changes”, then close the device configuration window. 
Retain this as a backup of the ASE’s configuration. 

14) Close the Romteck ASE Config application. 

15) Disconnect the Romteck RM3119 Programming Adaptor from the ASE. 

16) Carefully reseat the ASE front panel and reinstall the four retaining screws. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Activate the alarm on Input 5. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 6. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 7. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the alarm on Input 8. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Call Airservices ARFFS System Support. 

 

Confirm the following details: 

1) Your Name and Phone Number. 

2) The Building Name, Building Address and the ASE Device Number. 

3) Confirm the details of the additional alarms being added or removed. 

 

Keep the ASE in test mode until instructed otherwise. 

 

Airservices will then perform the following activities: 

1) Make the appropriate checks and system modifications. 

2) Notify the local ARFFS station of end-to-end testing, if applicable. 

3) Instruct you to remove the ASE from test mode. 

4) Instruct you to activate and clear additional alarms, if applicable. 

  

  

When instructed, remove the ASE from test mode.   

When instructed, activate the alarm on Input 5. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 6. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 7. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the alarm on Input 8. 

Wait for confirmation, then clear the alarm. 

  

  

 

Installer’s Signature:  Date:  

Comments:  

 

 

 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 
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13 Alteration of Service (RM3118) 
The installer must complete this checklist when modifying inputs on an existing RM3118 ASE. 

Prior to commencing this activity, an Application for Automatic Fire Alarm Monitoring Service form, 

requesting an Alteration of Service must be submitted to, and accepted by Airservices. 

Installer’s Name:  

Mobile Number:  

ASID Reference:  Device Number:  

Building Name:  

Building Address:  

 

CHECK ITEM Yes N/A 

Email arffsystemsupport@airservicesaustralia.com to organise a preferred time.   

Call the local ARFFS station and advise them you are on site to perform the alteration.   

Place the ASE into test mode prior to performing the alteration.   

Record the details for the additional alarm being wired to Input 3 EOLRB terminals. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

PRI:  SEC:  Either WIRED or BRIDGED 

The “ISO” EOLRB terminals on Input 3 must remain BRIDGED. 

  

  

Record the details for the additional alarm being wired to Input 4 EOLRB terminals. 

If this alarm is being removed, enter “REMOVED” for “Source:”. 

Source:  E.g., FIP / SPKL / MCP 

Description:  

PRI:  SEC:  Either WIRED or BRIDGED 

The “ISO” EOLRB terminals on Input 4 must remain BRIDGED. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 3. 

PRI Voltage Drop:  mV SEC Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 4. 

PRI Voltage Drop:  mV SEC Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Do the following to enable or disable additional inputs on the ASE: 

1) Unscrew the four retaining screws on the ASE front panel and carefully remove it. 

2) Connect the ASE to your laptop via a USB A to USB Micro B cable to connector P5. 

3) Launch the Romteck ASE Maintenance application. 

4) Navigate to “Setup” => “System Settings...” and select the 
“Communication Settings” tab. Ensure “Com Port:” is set to the correct port, 
then click “OK”. 
Hint: The exact COM port number associated with the ASE will depend on your system, the USB port 
used, as well as the number of existing COM ports present. To check COM port allocations, open 
“Device Manager” and expand “Ports (COM & LPT)”, then look for “USB Serial Port (COM#)” where 
“#” is the COM port number. 

5) In the list of devices, locate the ASE by matching its “Firemon Device No” to the ASE’s 
Device Number per the information at the top of this checklist. 

6) Right-click on the device and click “Connect”. 
This will display the device configuration window. 

7) Verify you see “Comms State:   COMMS OK: ...” at the bottom of the window. 

8) Click “Read Configuration”. 
On the warning prompt, click “Yes”. 
On the information prompt, click “OK”. 

9) Select the “Configuration” tab. 

10) On the “Input Enables (X = Enabled):” row, click the button corresponding to the additional 
inputs to enable or disable them. Do NOT modify inputs 1 and 2. 
Example showing additional Input 3 enabled: 

 

 

11) Click “Write Configuration”. 
On the information prompt, click “OK”. 

12) Click “Save Changes”, then close the device configuration window. 
Retain this as a backup of the ASE’s configuration. 

13) Close the Romteck ASE Maintenance application. 

14) Disconnect the USB cable from the ASE. 

15) Carefully reseat the ASE front panel and reinstall the four retaining screws. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Activate the alarm (PRI) on Input 3. 

Verify “ALARM Z3” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the fault (SEC) on Input 3. 

Verify “FAULT Z3” appears on the ASE’s LCD. 

Clear the fault. 

  

  

Activate the alarm (PRI) on Input 4. 

Verify “ALARM Z4” appears on the ASE’s LCD. 

Clear the alarm. 

  

  

Activate the fault (SEC) on Input 4. 

Verify “FAULT Z4” appears on the ASE’s LCD. 

Clear the fault. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Call Airservices ARFFS System Support. 

 

Confirm the following details: 

1) Your Name and Phone Number. 

2) The Building Name, Building Address and the ASE Device Number. 

3) Confirm the details of the additional alarms being added or removed. 

 

Keep the ASE in test mode until instructed otherwise. 

 

Airservices will then perform the following activities: 

1) Make the appropriate checks and system modifications. 

2) Notify the local ARFFS station of end-to-end testing, if applicable. 

3) Instruct you to remove the ASE from test mode. 

4) Instruct you to activate and clear additional alarms, if applicable. 

  

  

When instructed, remove the ASE from test mode.   

When instructed, activate the alarm (PRI) on Input 3. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the fault (SEC) on Input 3. 

Wait for confirmation, then clear the fault. 

  

  

When instructed, activate the alarm (PRI) on Input 4. 

Wait for confirmation, then clear the alarm. 

  

  

When instructed, activate the fault (SEC) on Input 4. 

Wait for confirmation, then clear the fault. 

  

  

 

Installer’s Signature:  Date:  

Comments:  

 

 

 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 
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14 Disconnecting and Reconnecting of an ASE 
(RM3119) 

Should an ASE be disconnected and reconnected for any reason, upon the reconnection the below 

checklist shall be conducted.  If a building remains occupied while this work is carried out, upon 

completion it is essential that the below checklist testing be completed at the time of reconnection.  

If the building is not occupied when the work is completed, the below checklist testing shall be 

completed as soon as practical. Email the signed form to: 

arffsystemsupport@airservicesaustralia.com. 

Installer’s Name: 

Mobile Number: 

ASID Reference: Device ID: 

Building Name: 

Building Address: 

CHECK ITEM Yes N/A 

Call the local ARFFS station and advise them about the nature of the activity. 

Place the ASE into test mode. Record the start date and time of the activity below. 

Date:  Time: 

Once the activity has been completed, confirm the ASE is: 

1) Powered on and displaying a status of “Normal”.

2) Displaying a signal strength for “P”, not flashing, and with alternating up/down arrow icon.

3) Displaying a signal strength for “S”, and not flashing.

Measure and record the voltage drop across the terminals for “ALM” on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

Measure and record the voltage drop across the terminals for “FLT” on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

Measure and record the voltage drop across the terminals for “ISO/DIS” on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

Measure and record the voltage drop across the terminals for “PWR” on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

Continued on next page. 
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CHECK ITEM Yes N/A 

Measure and record the voltage drop across the terminals for Input 5 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 6 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 7 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across the terminals for Input 8 on the resistor board. 

Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Call the local ARFFS station and advise them you are about to test the alarms. 
Stay on the line with the ARFFS station so you can confirm they receive the alarms. 

  

  

Activate the Alarm on Input 1. 

Verify “ALM” appears on the ASE’s LCD. 

Verify the ARFFS station has received the primary alarm. 

Clear the Alarm. 

  

  

Activate the System Fault on Input 2. 

Verify “FLT” appears on the ASE’s LCD. 

Verify the ARFFS station has received the secondary alarm. 

Clear the System Fault. 

  

  

Activate the Isolated / Disconnected on Input 3. 

Verify “DIS” appears on the ASE’s LCD. 

Verify the ARFFS station has received the status. 

Clear the Isolated / Disconnected status. 

  

  

Activate the Power Fault on Input 4. 

Verify “PWR” appears on the ASE’s LCD. 

Verify the ARFFS station has received the secondary alarm. 

Clear the Power Fault. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Activate the alarm on Input 5. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm as the correct type. 

Clear the alarm. 

  

  

Activate the alarm on Input 6. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm as the correct type. 

Clear the alarm. 

  

  

Activate the alarm on Input 7. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm as the correct type. 

Clear the alarm. 

  

  

Activate the alarm on Input 8. 

If the alarm type is PRIMARY, verify “ALM” appears on the ASE’s LCD. 

If the alarm type is SECONDARY, verify “FLT” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm as the correct type. 

Clear the alarm. 

  

  

Remove the ASE from test mode. Record the end date and time of the activity below. 

Date:  Time:  
 

  

  

 

Installer’s Signature:  Date:  

Comments:  

 

 

 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 
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15 Disconnecting and Reconnecting of an ASE 
(RM3118) 

Should an ASE be disconnected and reconnected for any reason, upon the reconnection the below 

checklist shall be conducted.  If a building remains occupied while this work is carried out, upon 

completion it is essential that the below checklist testing be completed at the time of reconnection.  

If the building is not occupied when the work is completed, the below checklist testing shall be 

completed as soon as practical. Email the signed form to: 

arffsystemsupport@airservicesaustralia.com. 

Installer’s Name:  

Mobile Number:  

ASID Reference:  Device ID:  

Building Name:  

Building Address:  

 

CHECK ITEM Yes N/A 

Call the local ARFFS station and advise them about the nature of the activity.   

Place the ASE into test mode. Record the start date and time of the activity below. 

Date:  Time:  
 

  

  

Once the activity has been completed, confirm the ASE is: 

1) Powered on, displaying “INPUTS  Normal” and “COMMS  Normal”. 

2) Displaying a signal strength for “P”, not flashing, and with alternating up/down arrow icon. 

3) Displaying a signal strength for “S”, and not flashing. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 1. 

PRI Voltage Drop:  mV SEC Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 2. 

ISO Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 3. 

PRI Voltage Drop:  mV SEC Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

Measure and record the voltage drop across each set of non-bridged terminals for Input 4. 

PRI Voltage Drop:  mV SEC Voltage Drop:  mV 

The voltage drop must be less than 10mV. See Appendix D. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Call the local ARFFS station and advise them you are about to test the alarms. 
Stay on the line with the ARFFS station so you can confirm they receive the alarms. 

  

  

Activate the Alarm on Input 1. 

Verify “ALARM Z1” appears on the ASE’s LCD. 

Verify the ARFFS station has received the primary alarm. 

Clear the Alarm. 

  

  

Activate the Fault on Input 1. 

Verify “FAULT Z1” appears on the ASE’s LCD. 

Verify the ARFFS station has received the secondary alarm. 

Clear the Fault. 

  

  

Activate the Zone Isolate on Input 2. 

Verify “ISOLATE Z2” appears on the ASE’s LCD. 

Verify the ARFFS station has received the status. 

Clear the Zone Isolate. 

  

  

 

Continued on next page.  
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CHECK ITEM Yes N/A 

Activate the alarm (PRI) on Input 3. 

Verify “ALARM Z3” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm. 

Clear the alarm. 

  

  

Activate the fault (SEC) on Input 3. 

Verify “FAULT Z3” appears on the ASE’s LCD. 

Verify the ARFFS station has received the fault. 

Clear the fault. 

  

  

Activate the alarm (PRI) on Input 4. 

Verify “ALARM Z3” appears on the ASE’s LCD. 

Verify the ARFFS station has received the alarm. 

Clear the alarm. 

  

  

Activate the fault (SEC) on Input 4. 

Verify “FAULT Z3” appears on the ASE’s LCD. 

Verify the ARFFS station has received the fault. 

Clear the fault. 

  

  

Remove the ASE from test mode. Record the end date and time of the activity below. 

Date:  Time:  
 

  

  

 

Installer’s Signature:  Date:  

Comments:  

 

 

 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 
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16 Replacement ASE 
Fire alarm systems are complex in design, and need to be maintained by the customer’s reputable 

fire maintenance company that has expertise in this field. Whenever there is a fault with the fire 

alarm monitoring equipment, Airservices will notify the customers. The responsibility to rectify any 

fault / defect resides with the customer as the owner / occupier of the building. The 

installer/maintainer holds a stockpile of ASEs that are to be used to replace a customer’s failed 

device. The process will depend on the failure mode. As a guide the process will typically involve: 

1) The two SIMS are to be installed in the new hardware 

2) The ASE Maintenance application and Appendix A.1.4 procedures are to be used to load the 

ASE configuration. 

3) Section 11 checks shall be conducted and emailed to Airservices. 

 

17 Replacement SIM 

1) Contact Airservices arffsystemsupport@airservicesaustralia.com to order a replacement SIM. 

2) Send faulty SIM to: 

 

ARFFS System Support, Airservices Australia 

Alan Woods Building 

25 Constitution Avenue 

Canberra ACT 2601 

 

18 Misuse of Airservices SIMs 
Airservices performs a monthly audit of SIM usage. If Airservices detects a SIM is being misused, 

Airservices will: 

1) Notify the customer using the normal fault notification process. 

2) Deactivate the misused SIM. 

3) Send a replacement SIM to the customer. 

4) Invoice the customer for the extra SIM charges. 
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19 ASE Decommissioning 
Once an ASE is installed, a building permit from a registered building surveyor must be obtained to 

disconnect it. To decommission an ASE, a Removal of Service form must be submitted to 

arfffirealarmmonitoring@airservicesaustralia.com. 

The following checklist is to then be completed. Email the signed form to 

arffsystemsupport@airservicesaustralia.com. 

Installer’s Name: 

Mobile Number: 

ASID Reference: Device ID: 

Building Name: 

Building Address: 

The following checklist is to be completed by the Installer: 

CHECK ITEM Yes N/A 

Confirmation received from Airservices that the ASE configuration has been cleared. 

Remove the ASE from the FDCIE. 

Send the Telstra and Optus SIMs to: 

ARFFS System Support 
Airservices Australia 
Alan Woods Building 
25 Constitution Avenue 
Canberra ACT 2601 

Note: Airservices will de-activate the Telstra and Optus SIMs. 

Installer’s Signature: Date: 

Comments: 

Note: Electronic submissions are not required to be signed. 

Email this completed form to: arffsystemsupport@airservicesaustralia.com 

http://www.airservicesaustralia.com/wp-content/uploads/Application-for-Automatic-Fire-Alarm-Monitoring.pdf
mailto:arfffirealarmmonitoring@airservicesaustralia.com
mailto:arffsystemsupport@airservicesaustralia.com
mailto:arffsystemsupport@airservicesaustralia.com
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20 Definitions 
Within this document, the following definitions apply: 

Term Definition 

ALM (alarm monitoring) Fire Alarm 

ARFFS Aviation Rescue Fire Fighting Service 

ASE Alarm Signalling Equipment 

AWG American Wire Gauge 

COM (relay / switch contacts) Common 

COM (port) Serial communications port 

DC Direct Current 

EOLRB End Of Line Resistor Board 

FCC Fire Control Centre 

FDCIE Fire Detection Control and Indicating Equipment 

FIP Fire Indicator Panel 
Legacy terminology for FDCIE. 

FLT (alarm monitoring) System Fault 

FTDI Future Technology Devices International Limited 

GPRS General Packet Radio Service 

HSDPA High Speed Downlink Packet Access 

ISO/DIS (alarm monitoring) Isolated / Disconnected 

LCD Liquid Crystal Display 

MCP Manual Call Point 

N.C. Normally Closed 

N.O. Normally Open 

PC Personal Computer 

POTS Plain Old Telephone System 

PWR (alarm monitoring) Power Fault 

RB Resistor Board (See also EOLRB) 

SIM Subscriber Identification Module 

SMA SubMiniature version A 

SPDT Single Pole Double Throw 

SPKL Sprinkler 

SPST Single Pole Single Throw 

USB Universal Serial Bus 
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Term Definition 

USB-A USB Type-A plug / port 

USB-C USB Type-C plug / port 

WIP Wireless Internet Protocol 

21 References 

Title 

ASE Maintenance Configuration and Diagnostics Software for ASE and FSE Devices 

Firemon Fire Alarm Signalling Equipment (ASE) Configuration, Integration and Commissioning 

Romteck ASE CONFIG Operation Manual 

ROMTECK RM3118 Alarm Signalling Equipment (ASE) Operation and Installation Manual 

Romteck RM3119 ASE Installation Manual 

Romteck RM3119 ASE Operations Manual 
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Appendix A How to Backup or Restore RM3119 Dual 

SIM ASE Configuration 

A.1 ASE Config Software 

A.1.1 External Customer Technicians  

The latest version of ASE Config Software and Romteck RM3119 ASE Installation Manual are 

ordered via the TI-0223 process  

Note: ASE Config Software Version 1.15.0 or higher is required. Airservices recommends only 

installing the software on Windows 10 or later. 

 

 

  

https://www.airservicesaustralia.com/wp-content/uploads/TI-0223-Certified-Maintainer-Assessment-for-ASE.pdf
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A.1.2 Initial Setup and Licensing 

When connecting the Romteck RM3119 Programming Adaptor for the first time, ensure the PC / 

laptop is connected to the network, as Windows may need to download and install the appropriate 

USB-to-Serial FTDI driver. Once the driver is installed, the PC does not need to remain connected 

to the network.   

1) On the PC / laptop, start “Device Manager”.  

2) Use a USB-C cable to connect the Romteck RM3119 Programming Adaptor to your 

PC / laptop. 

3) Wait a few moments for Windows to retrieve and install the device driver. 

4) Verify a new com port is listed under “Device Manager” => “Ports (COM & LPT)” called 

“USB Serial Port (COMX)” where “X” is the com port number. 

Note that if you connect the Romteck RM3119 Programming Adaptor to a different USB 

port, or another USB to serial adaptor is connected, the assigned COM port number may 

change. 

 

ASE Config installs in Express Mode and requires a license to operate in Unrestricted Mode. 

Use the following procedure to license ASE Config. 

1) Launch ASE Config. 

2) Navigate to “Help” > “License Manager…” and select “Request License” 

3) Save the generated license request file “.lrq” to the desktop. 

4) Email a license request to licenses@romteck.com with the “.lrq” file attached. 

5) Once Romteck respond with a license, save the attached “.lic” to your PC / laptop. 

6) Navigate to “Help” > “License Manager…” and select “Install License”. 

7) Browse to and select the “.lic” file, then click “Open” 

8) On the “Confirm” prompt, verify the details are correct, then click “Yes” 

 

ASE Config must be pointed to the correct com port. Use the following procedure to set the com 

port number ASE Config will use. 

1) Navigate to “Setup” > “System Settings…” 

If you receive a “Com Port is not available” error, click “OK” 

2) Select the “Communication Settings” tab 

3) In the “Com Port:” dropdown, select the port associated with the Romteck RM3119 

Programming Adaptor connected to your PC / laptop, then click “OK” 

 

  

mailto:licenses@romteck.com
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A.1.3 Saving an ASE’s Configuration 

1) Use a USB-C cable to connect the RM3119 Programming Adaptor to your PC / laptop.

2) Insert the Romteck RM3119 Programming Adaptor into connector “P6” on the ASE.

3) Start the ASE Config application.

4) Select “File” > “Add Device…”.

5) Select “Type 53: RM3119-WIP-WIP-ASE-F” and click “OK”.

This will create and highlight a new device in the list.

6) Right-click the newly created device and select “Connect”

If an “Address Mismatch …” prompt displays, click “OK”

7) On the bottom left of the device window, confirm you see

“Comms State:  COMMS OK: …”.

8) On the top right of the device window, click “Read Configuration”

You will be prompted to confirm. Click “Yes”.

9) Verify you receive a “Read configuration command completed successfully” prompt.

Click “OK”

10) Click the “Configuration” tab.

11) The “LCD Title:” field will contain “DEVICE ###”,

where “###” is the Firemon Device Number. Copy this number.

12) Click the “Device Details” tab.

13) Update the “Firemon Device No” field with the number you copied in Step 11.

14) Update the “Building” field with the Firemon Device Number, building name and address.

Important: The Firemon Device Number is added to the “Building” field as the ASE Config

application currently does not allow the “Firemon Device No” field to be included in the

filenames of exported devices.

Additionally, ensure the text in the “Building” field does not match any other devices’

“Building” field in the ASE Config application. For instance, if you have multiple backups of

the same device, add a date code to the field.

15) On the bottom right of the device window, click “Save Changes”

16) Close the device window.

17) Remove the Romteck RM3119 Programming Adaptor from connector “P6” on the ASE.

Continued on next page. 
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18) Select “File” > “Export All Devices…”. 

Important: Do not use “File” > “Export Device” as it does not include sufficient meta data in 

the file name. 

19) On the “Export All Devices” dialogue, click “Define fields…” 

20) On the fields selection prompt, do the following: 

a) Click “<<” 

b) Select “Building (Prompt 1)” and click “>”. 

c) Select “Device Address (Conc_Module_Line_Drop)” and click “>”. 

d) Verify “Fields in file name” lists only the following in order: 

Building (Prompt 1) 

Device Address (Conc_Module_Line_Drop) 

e) Click “OK” 

21) Ensure the “Export Directory” field is set to 

“C:\ProgramData\Romteck\ASEConfig\Export\”. 

Alternatively, select another suitable location to store the exported data. 

22) Click “OK” and wait for the export to complete. 

23) Verify you receive a “Successfully exported all device data to:” prompt. 

Click “OK”. 

24) Navigate to “C:\ProgramData\Romteck\ASEConfig\Export\”, or the alternative location you 

selected for the export in Step 21. 

25) Copy or archive the zip file as per your company’s policy. 

26) If this backup is for an Airservices internal device, e-mail the zip file to 

arffsystemsupport@airservicesaustralia.com 
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A.1.4 Restoring an ASE’s Configuration 

Warning: BEFORE you proceed, ensure the Telstra and Optus micro-SIMs are NOT installed. 

1) Use a USB-C cable to connect the RM3119 Programming Adaptor to your PC / laptop.

2) Insert the Romteck RM3119 Programming Adaptor into connector “P6” on the ASE.

3) Power on the ASE.

4) Start the ASE Config application.

5) Select “File” > “Import Device(s)…”

6) Navigate to the location of the device to import and select the zip file, then click “Open”

7) Confirm you receive an “Import Successful …” prompt. Click “OK”

The imported device will be highlighted in the list.

Alternatively, sort by the “Device No” column and select the last device.

8) Right-click on the imported device and select “Connect”

If an “Address Mismatch …” prompt appears, click “OK”

9) On the bottom left of the device window, confirm you see “Comms State:  COMMS OK: ...”.

10) On the top right of the device window, click “Write Configuration”

11) Verify you receive a “Write Configuration command completed successfully” prompt.

Click “OK”

12) Close the device window.

13) Remove the Romteck RM3119 Programming Adaptor from connector “P6” on the ASE.

14) Power off the ASE.

15) Install the Telstra micro-SIM into the onboard modem’s micro-SIM socket.

16) Install the Optus micro-SIM into the offboard modem’s micro-SIM socket.

Warning: Do NOT power on the ASE until it has been installed and wired into the FDCIE. The ASE 

will communicate back to the local ARFFS station once powered on. 
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Appendix B ARFFS Contact details  

ARFFS Station FCC Contact Number 

ADELAIDE  (08) 8154 4010 

ALICE SPRINGS (08) 8958 4710 

AVALON (03) 5282 7010 

AYERS ROCK (08) 8956 1910 

BALLINA (02) 6618 7710 

BRISBANE (07) 3860 3210 

BROOME (08) 9194 3310 

CAIRNS (07) 4042 4910 

CANBERRA (02) 6243 2110 

COFFS HARBOUR (02) 6691 7610 

COOLANGATTA (07) 5590 2710 

DARWIN (08) 8920 4810 

GLADSTONE (07) 4973 5410 

HAMILTON ISLAND (07) 4948 5610 

HOBART (03) 6248 3410 

KARRATHA (08) 9183 6210 

LAUNCESTON (03) 6391 6810 

MACKAY (07) 4968 3010 

MELBOURNE (03) 9286 3110 

NEWMAN (08) 9130 7110 

PERTH (08) 9373 9210 

PORT HEDLAND (08) 9158 5910 

ROCKHAMPTON (07) 4930 7410 

SUNSHINE COAST (07) 5458 2910 

SYDNEY (02) 9556 5510 

TOWNSVILLE (07) 4759 1810 

WHITSUNDAY COAST (07) 4945 6910 
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Appendix C Notification Form 204 Explanations & ASE 

Status Screen 

Refer to Section 3.7 “Viewing The LCD” in the Romteck RM3119 ASE Installation Manual. 
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Appendix D Notification Form 204 High Number of 

FDCIE Faults 

If a high number of FDCIE faults are being reported, do the following: 

1) Check if the FDCIE is generating the faults. Take corrective action on the FDCIE if necessary.

2) Inspect the wiring between the FDCIE, resistor board and ASE. Check for signs of moisture,

corrosion, or other damage. Check for loose or incorrect terminations. Replace, re-terminate,

and properly secure the wiring as necessary.

3) With the ASE connected to the FDCIE and powered on, use a multimeter to measure and

record the voltage drop between each pair of input terminals on the resistor board. Perform the

measurements while the associated FDCIE relay contacts are in the Normally Closed position.

If the voltage drop on a pair of input terminals is greater than 10mV, clean the relay contacts or

install a replacement relay if necessary.
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